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Introduction 
This guide is designed to help you understand the steps to upgrade Capital Gold Payroll, complete 

the year-end and start the 2024-25 tax year. You must follow these steps for each company in 

Capital Gold Payroll. 

The guide is designed to be read on-screen or printed. Make sure that you follow the instructions 

carefully. 

Audience 

This guide is provided for both Pegasus partners and Capital Gold Payroll customers. The guide 

assumes you have relevant knowledge of Capital Gold Payroll and understand existing HMRC 

requirements of employers.  

 

Download instructions 

Capital Gold Payroll (4.14.00) is available for download. Download instructions are included as a link 

in the release notification email. 

Pegasus Help Centre 

These guides are available from the Help menu in Capital Gold Payroll, and also by visiting the User 

Guides page for Capital Gold Payroll at docs.pegasus.co.uk or the Help menu guide section. 

Guide Description 

Legislation & 

Product Changes  

This guide is designed to help you understand the legislation and 

software changes to this year’s payroll upgrade for the 2023-24 year end 

and the new 2024-25 tax year.  

Installation This guide provides information concerning the installation of Capital 

Gold Payroll and the supported software environments.  

Auto Enrolment This guide will demonstrate how Capital Gold Payroll can help you carry 

out your Auto Enrolment responsibilities. 

Auto Enrolment 

Configuration Tool 

A guide that explains the Auto Enrolment Configuration Tool, which is 

accessed from the Pensions menu. 

F1 Help 

The help includes sections that describe the software changes in this release and explains each of 

the screens in the product. This can be accessed via Help - Capital Gold Payroll Help or by using 

the F1 button. 

 

 

PLEASE READ IMPORTANT NOTES CAREFULLY. 

https://docs.pegasus.co.uk/topic.htm?#t=Guides%2FUser_Guides_Capital_Gold_Payroll.htm
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Considerations before you start 
Before starting the steps, you may want to consider the notes in this section.  

Running weeks 53/54/56 
• Weekly payroll with a pay date of 5th April should be week 53 

• 2-weekly payroll with a pay date of 5th April should be week 54 

• 4-weekly payroll with a pay date of 5th April should be week 56. 

For week 53, 54 and 56 payrolls Capital Gold Payroll will automatically apply the week 1 tax basis as 

outlined by HMRC. You do not have to make any changes. 

Issuing P45s 

Before running the Year-end Restart, issue P45s for employees who you do not intend to pay in the 

2024-25 tax year. 

Please note that if you have leavers that relate to a previous pay period, you are required to 

send an FPS and ensure that you select 'H' (correction to earlier submission) as the report 

code.  If you do not select this report code, HMRC does not see all the leave information and 

could issue a penalty for late reporting. 

Directors NI calculations 

If you started using Capital Gold Payroll part way through the current tax year and imported your 

data from another payroll system, check year-to-date NI calculations for Directors. 

Follow HMRC leaflet CA44 National Insurance for company directors or use the Director’s National 

Insurance contributions calculator listed at www.gov.uk/government/collections/how-to-manually-

check-your-payroll-calculations. 

Running payrolls in the new tax year before printing P60s 

If you need to start running payrolls in the new tax year, before printing P60s, do the Year-end 

Restart and then run payrolls in the new tax year as normal. When you do the Year-end Restart, 

the company is copied automatically. 

YOUR FINAL FPS FOR THE 2023-24 TAX YEAR MUST BE SENT BEFORE 19 APRIL 2024. ANY 

CHANGES FOR THE 2023-24 TAX YEAR AFTER 19 APRIL 2024 MAY BE SUBMITTED USING AN FPS 

OR EARLIER YEAR FPS, OR BY USING HMRC BASIC TOOLS. 

When you are ready to print your P60s 

From the File menu, select Use Last Year’s Company Data. This restores the data to what it was 

before the Year-end Restart. 

A confirmation message is displayed. When the previous year’s data is in use, the tax year is 

displayed in the title bar after the company name. 

Print P60s as described in the Completing the Tax Year-End section on page 8 of this guide. 

Once finished, return to your current data by again selecting Use Last Year’s Company Data from 

the File menu. 

DO NOT PERFORM A SECOND YEAR-END RESTART WHEN YOU ARE USING LAST YEAR’S 

DATA. 

The Last Year copy is not a substitute for your end of year back up. When Capital Gold Payroll makes 

the automatic copy during the Year-end Restart, data already stored in the ‘LastYear’ folder for the 

current company is overwritten. This happens every time a Year-end Restart is done for that 

company so only the previous tax year’s copy is ever available. 

  

https://www.gov.uk/government/collections/how-to-manually-check-your-payroll-calculations
https://www.gov.uk/government/collections/how-to-manually-check-your-payroll-calculations


Checklists Guide 

2023-24 year-end & 2024-25 tax year 

 

Considerations before you start   Page 5 of 11 

GDPR Password consideration 

If you are still using the ‘default’ password(s) for your payroll software, that is, those provided on 

first installation, we strongly recommend you change them to help you comply with General Data 

Protection Regulation (GDPR). 

 

NB: IT IS RECOMMENDED NOT TO CHANGE THE ADMINISTRATOR PASSWORD 
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STEP 1: Upgrading Capital Gold Payroll 

THIS CHECKLIST DETAILS THE SUGGESTED STEPS FOR THIS PROCESS. PLEASE AMEND AS 

NECESSARY. 

This section includes the steps required to upgrade to Capital Gold Payroll (4.14.00) before 

completing the year end tasks.  

THE SOFTWARE CAN BE INSTALLED IN ANY PAY PERIOD BEFORE THE END OF THE 2023-24 TAX 

YEAR. HOWEVER, IT MUST BE INSTALLED BEFORE PROCESSING THE YEAR END.  

Before Upgrading the Software 

1. Capital Gold Payroll (4.13.02) should already be installed before upgrading as that 

release was required by all users following the Autumn Statement announcement. 

Use the Help - About Capital Gold Payroll menu in Capital Gold Payroll to check 

the version number. 

 

2. Backup the Capital Gold Payroll data files using the File - Back-up & Restore - 

Back-up Company Data command.  

 

It is advisable to back up your data to a 

new folder so that it does not overwrite an 

existing backup. In the Backup to box, first 

remove the text that is displayed. Then 

enter the drive letter and a new folder 

name for the current pay period, for 

example ‘C:\March2024_A’. 

 

 

3. Carry out a full payroll cycle using the Payroll - Do/Redo Payroll command for 

each company and print the necessary reports. 
 

4. Close Capital Gold Payroll. 
 

Upgrading the Software 

5. Install the software before processing starts in the new pay period. 

 

Separate instructions for 

downloading the installation files are 

included with your release letter. 

This screen will appear automatically 

after the software has downloaded 

and you run the ‘4.14.00_install.exe’ 

file. 
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6. Familiarise yourself with the legislation that affects this release by clicking the Latest 

News or the Guides link. Click View Readme to see a summary of the software 

changes. 

 

7. Click Install Capital Gold Payroll to upgrade the product. Follow the instructions on 

the screen to complete the upgrade. When asked, use the ‘Typical’ set up type. 

Ignore the ‘Typical Update’ and ‘Custom’ types. 

 

After Upgrading the Software 

8. Log in to Capital Gold Payroll and choose Help - About Capital Gold Payroll ….  

Under Licence Details the text ‘Latest Tax & NI Rates Correct at April 2024 (Not 

Using)’ should be displayed. 

 

If the ‘Latest Tax & NI Rates Correct at April 2024 (Not Using)’ caption is not shown, 

the upgrade was not successful. Check that you have upgraded the program in the 

correct folder and try again. If this is still not successful, contact your support 

provider for advice. 

THE CAPTION ‘IN USE’ WILL APPEAR IN THE NEW TAX YEAR. 
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STEP 2: Completing the Tax Year-End 
 

Here is a reminder of the tasks to carry out at the end of the 2023-24 tax year, for each of the 

Capital Gold Payroll companies. This procedure applies only when the current period is the last 

period in the tax year.  

USE THE F1 HELP FOR ASSISTANCE WITH THE SCREENS. 

Before Completing the Year-End 

1. Backup the Capital Gold Payroll data files using the File - Back-up & Restore - 

Back-up Company Data command. 

 

It is advisable to back up your data to a new 

folder so that it does not overwrite an 

existing backup. In the Backup to box, first 

remove the text that is displayed. Then 

enter the drive letter and a new folder name 

for the current pay period, for example 

‘C:\March2024_B’. 

 

 

Completing the Year-End 

PLEASE COMPLETE THESE STEPS IN ADDITION TO COMPLETING MONTH-END REPORTS AND 

OTHER USUAL PAY PERIOD TASKS FOR EACH COMPANY ON YOUR PAYROLL. 

YOU MUST CREATE AND SUBMIT THE FPS FILE FOR THE FINAL 2023-24 PAY PERIOD AS 

NORMAL, BEFORE COMPLETING THE TAX YEAR END. OUR RECOMMENDATION IS ALSO TO 

CREATE THE FINAL EPS FILE IMMEDIATELY AFTER THE FINAL FPS IS SUBMITTED TO HMRC. 

2. Install the Employers Annual Summary report. Select the Reports - Library 

Selection - Summaries command and double-click the Employers Annual 

Summary report. Then close the screen. 

 

3. Open the HMRC Details screen from Company – Company Details and check the 

monthly figures. If there are figures that have not been updated, run the Month-end 

Summary from the Reports menu for those months. 

 

 

4. Select the Reports - Year to-date Summary command: 

i. Print the Employers Annual Summary report. 

ii. Print the Year to Date Summaries report for the entire payroll. This prints a 

substitute for the official P35 CS form and a year-end summary for the company 

that you can use for a file-copy. 
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5. Select the Reports - Library Selection - Miscellaneous command to select the P60 

(End of Year Certificate) from the library. Double-click to select one of P60 HMRC 

Laser Single Sheet, Pegasus Pre-Printed Laser P60 (Sealed) or P60 Plain Paper 

(Pegasus). 

 

6. Select the Reports - Year-end Forms command to print a P60 for each employee. 

Make sure your printer is loaded with the P60 stationery for the 2023-24 tax year. 

• THIS CAN BE DONE AFTER THE YEAR-END IF NECESSARY. 

• A P60 WILL NOT BE PRINTED FOR LEAVERS. 

 

Completing the Year-End 

7. After all FPS submissions have been sent to HMRC for the 2023-24 tax year, you 

MUST send an EPS for the end of the tax year, even if Recoverable Amounts or CIS 

deductions don't apply. 

Open the Online Services - Send Employer Payment Summary form to create the 

final EPS file for the tax year and select the Final Employer Payment Summary for 

Tax Year checkbox. 
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STEP 3: Starting the New Tax Year 

THIS CHECKLIST DETAILS THE SUGGESTED STEPS FOR THIS PROCESS. PLEASE AMEND AS 

NECESSARY TO MATCH YOUR NORMAL PAYROLL TASKS. 

Before using Capital Gold Payroll (4.14.00) in the 2024-25 tax year, the information for the old tax 

year for each company on the payroll needs to be cleared. Here is a list of tasks to start the new tax 

year in Capital Gold Payroll. 

USE THE F1 HELP FOR ASSISTANCE WITH THE SCREENS. 

Running the Year-end and Checking Details & Options 

1. Backup the Capital Gold Payroll data files using the File - Back-up & Restore - 

Back-up Company Data command. 

 

It is advisable to back up your data to a new 

folder so that it does not overwrite an existing 

backup. In the Backup to box, first remove the 

text that is displayed. Then enter the drive 

letter and a new folder name for the current 

pay period, for example ‘C:\March2024_C’. 

 

 

2. Select the Company - Year-end Restart command.  

To confirm you want to continue, click either OK or Cancel as necessary.  

A DATA BACKUP IS COPIED AUTOMATICALLY TO A FOLDER CALLED ‘LASTYEAR' 

IN THE MAIN CAPITAL ‘GOLD PAYROLL’ FOLDER, WHICH BY DEFAULT IS 

‘C:\PEGASUS\GOLD PAYROLL\ LASTYEAR’. ANY FILES THAT ALREADY EXIST IN THE 

FOLDER WILL BE OVERWRITTEN. 

 

3. On the Year-end Restart screen, click to select the to-date totals to clear down in 

the column to the right of the Pay Rate and Payment & Deduction descriptions 

(only to-date totals are cleared). Many are already selected by default. Click again to 

reverse the selection if necessary.  

Then click OK. 

 

4. If Capital Gold Payroll Plus Pack is activated, clear the year’s history records if 

required. On the next Year-end Restart form select the drop-down lists to delete 

the year’s records for pay history, diary entries, and costing records.  

Then click OK. 

 

5. Click OK to confirm the new tax year and complete the year-end.  

Any employees with an ‘L’, ‘M’ or ‘N’ prefix tax code are automatically updated with 

the new codes for the 2024-25 tax year. 

 

6. From 06/04/2024 the total minimum Auto Enrolment contributions remains the 

same at 8% - with the employer contributing at least 3%.  

If you need to change the contribution rates, use the Tools – Global Changes 

command to update pensions deduction rates on the Employees Details screen. 

Update the Company Payments & Deductions screen for new deductions. 

 

7. Create employee records for new employees starting at the beginning of the new tax 

year using Add New Employee. 
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Running the Year-end and Checking Details & Options 

8. You may need to amend existing employee details using Alter Current Employee or 

Tools – Global Changes. For example, changing an employee’s tax or NI code, 

Student Loans, Postgraduate Loans, company director status or Scottish/Welsh 

taxpayer status. 

 

9. Update your Company Options screen for the NICs Employment Allowance, Small 

Employer Relief and Apprenticeship Levy. 
 

10. If your payroll company car benefits and have registered with HMRC to do so before 

the start of the tax year, add company car details and allocate them to the 

employees using the Configure Company Car Details screen if necessary. 

Please refer to the help to ensure all relevant, existing and new, fields have been 

entered. 

 

11. To help with running payroll in the new tax year, update the Payroll Calendar screen 

with Payroll Dates and BACS Creation Dates and Processing Dates. Also, check 

that the work period dates are correct. 

 

12.  For those employees who have attachment of earnings orders, review the 

outstanding balances by opening the Employee details screen and clicking the AEO 

Settings screen on the Pay/Deds tab. 

 

13. If off payroll workers are contracted, tick the Off-payroll worker check box on the 

Period tab of the Employee record so that the employee record is set as off payroll. 
 

14. From the 2024-25 Tax Year the Employment Allowance is a type of De-minimis 

state aid.  Employers need to re-apply for the De-minimis State Aid Employment 

Allowance at the start of each Tax Year.  This is set in the Company Options.  Please 

refer to the help for further information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

End of Guide 


